UNIT I: Introduction to Business Intelligence

Definition of BI — Historical Perspective of BI- Architecture of BI- Data
Warehouse, Business Analytics, Business Performance Management,
User Interface, Cyclical process of a business intelligence analysis.

1Q. What is Business Intelligence (BI)? Write briefly about
its history.

Definition: Business intelligence (BI) is software that collects business
data and presents it in user-friendly views such as reports, dashboards,
charts and graphs. As part of the BI process, organizations collect data
from internal and external sources, prepare it for analysis, run queries
against the data and create data visualizations called BI dashboard. The
BI dashboards and reports to make the analytics results available to
business users for operational decision-making and strategic planning.

The ultimate goal of BI initiatives is to drive better business decisions
that enable organizations to increase revenue, improve operational
efficiency and gain competitive advantages over business rivals.

Historical Perspective of BI

« In 1865, Richard Millar Devens presented the phrase “Business
Intelligence” (BI) in the “Cyclopaedia of Commercial and Business
Anecdotes.”

in 1958, an article was written by an IBM computer scientist
named describing the potential of gathering business intelligence
(BI) through the use of technology.

In 1968, individuals with extremely specialized skills could
translate data into usable information. At this time, data from
multiple sources was normally stored in silos and the report was
open to interpretation.

Decision Support System was the first database management
system to be developed. Many historians suggest the modern
version of business intelligence evolved from the DSS database.
Numerous tools were developed during this time, to access and
organize data in simpler ways.

Online analytical processing (OLAP) is a system that allows
users to analyse data from a variety of sources while offering
multiple paradigms or perspectives. Databases configured for
OLAP use a multidimensional data model, supporting complex
analysis and adhoc queries. LAP was quite popular because of the
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variety of ways it offered to assemble and organize information. It
supports consolidation, drill down and slicing and dicing.

In 1970s, CEOs began using the internet to research business
information. This led to the development of software, called
executive information systems (EIS), to support upper
management in making decisions.

Data Warehouses started becoming popular in the 1980s, as
businesses began using in-house data analysis solutions
regularly.

2Q. Explain Architecture of BI with Diagram.

There are various components and layers that business intelligence
architecture consists of. Each of those components has its own purpose.
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A solid BI architecture framework consists of:

Collection of data: The first step in creating a stable architecture starts
with gathering data from various data sources such as CRM, ERP,
databases, files, or APIs, depending on the requirements and resources
of a company. Modern BI software offers a lot of different, fast, and easy
data connectors to make this process smooth and easy by using smart
ETL engines in the background. They enable communication between
scattered departments and systems that would otherwise stay
disparate.

Data Integration: At this stage, the data collected is integrated into a
centralized system, often with the help of ETL processes. Here the data
is also cleaned and prepared for analysis.

Storage of data (Data Warehouse): This is where a DWH comes into
the picture. A warehouse is a place in which structured data is stored.
It makes it available for querying and analysis.

Data analysis: After the information is processed, stored, and cleaned
it is ready to be analysed. With the help of the right BI tools, the data is
visualized and used for strategic decision-making.
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Distribution of data: The data, now in the form of graphs and charts,
is distributed in different formats. This can be online reporting, dash
boarding, or embedding solutions.

Reaction based on insights: The final stage of the architecture is to
extract actionable insights from the data and use them to make
improved decisions to ensure company growth.

3Q. Explain Data Warehouse in detail.

A Data Warehouse is separate from DBMS, it stores a huge amount of
data, which is typically collected from multiple heterogeneous sources
like files, DBMS, etc. The goal is to produce statistical results that may
help in decision-making. An ordinary Database can store MBs to GBs
of data and that too for a specific purpose. For storing data of TB size,
the storage shifted to the Data Warehouse. Effectively perform
analytics, an organization keeps a central Data Warehouse to closely
study its business by organizing, understanding, and using its
historical data for making strategic decisions and analysing trends.
Data Warehouse Architecture

A data-warehouse is a heterogeneous collection of different data sources
organised under a unified schema. There are 2 approaches for
constructing data-warehouse: Top-down approach and Bottom-up
approach.

Top-down approach

Staging A
aging Area Datawarehouse

External Sources

The essential components are:

External Sources — External source is a source from where data is
collected irrespective of the type of data. Data can be structured, semi
structured and unstructured as well.
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Stage Area

Since the data, extracted from the external sources does not follow a
particular format, so there is a need to validate this data to load into
Data warehouse. For this purpose, it is recommended to use ETL tool.
E(Extracted): Data is extracted from External data source.

T(Transform): Data is transformed into the standard format.

L(Load): Data is loaded into Data warehouse after transforming it into
the standard format.
Data-warehouse

After cleansing of data, it is stored in the Data warehouse as central
repository. It actually stores the meta data and the actual data gets
stored in the data marts. Note that Data warehouse stores the data in
its purest form in this top-down approach.

Data Marts

Data mart is also a part of storage component. It stores the information
of a particular function of an organisation which is handled by single
authority. There can be as many numbers of data marts in an
organisation depending upon the functions.

Data Mining

The practice of analysing the big data present in dataware house is data
mining. It is used to find the hidden patterns that are present in the
database or in dataware house with the help of algorithm of data mining.

Bottom-up approach:

Staging Are Oata
aging Area
gine ET
External Sources
Data Datawarehouse
Mart
Data W
Mart

+ First, the data is extracted from external sources (same as

happens in top-down approach).
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* Then, the data go through the staging area (as explained above)
and loaded into data marts instead of Datawarehouse. The data
marts are created first and provide reporting capability. It
addresses a single business area.

+ These data marts are then integrated into dataware house.

This approach is given by Kinball as — data marts are created first and
provides a thin view for analyses and Datawarehouse is created after
complete data marts have been created.

4Q. Write about Business Analytics.

Definition: Business Analytics (BA) is a combination of disciplines and
technologies that use data analysis, statistical models, and other
quantitative methods to solve business problems. It entails an iterative
investigation of an organization's data to drive decision-making, with a
focus on statistical analysis.

The four main analytical models organisations can deploy are:

Descriptive Analytics
Diagnostic Analytics
Predictive Analytics

Prescriptive Analytics

Descriptive Analytics: Descriptive analytics gives the information of
what has happened? It generally uses historical data from a single
internal source to pinpoint when an event occurred.

For example:

« How many sales did we make in the last week/day/hour?
 How many people viewed our website?
Predictive analytics: Predictive analytics tries to answer the question:
What will happen next? It shifts its focus from understanding historical
events to creating insights about a current or future state. Predictive
analytics uses statistical analysis and artificial intelligence (Al)
techniques.
Prescriptive analytics: Prescriptive analytics is the most complex type
of analytics. It combines internal data, external sources, and machine
learning techniques to provide the most effective outcomes.

5Q. Explain the Role of Business Performance

Management (BPM) in BI.
Business performance management (BPM) is a form of business
intelligence used to monitor and manage a company’s performance.
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Business process management (BPM) is a discipline involving any
combination ofmodelling, automation, execution, control, measurement
and optimization of business activity flows, in support of enterprise
goals, spanning systems, employees, customers and partners within
and beyond the enterprise boundaries.

Key performance indicators (KPI) are used for this purpose. These KPIs
include revenue, return on investment, overhead and operational costs.
It is also known as corporate performance management (CPM).

BPM allows companies to collect data efficiently from various sources,
analyse it and use this knowledge to improve the company’s
performance.

BPM also allows problems to be identified before they have a chance to
grow and spread into other areas of the company. Finally, it can be used
to make more predictable and reliable forecasts.

Business process management (BPM) is the discipline in which people
use various methods to discover, model, analyse, measure, improve,
optimize, and automate business processes.

Any combination of methods used to manage a company's business
processes is BPM.

Processes can be structured and repeatable or unstructured and
variable. Though not required, enabling technologies are often used
with BPM.

Continuous and real-time reviews of data are used in the BPM process.
Business performance management software has traditionally been
used within finance departments, but it is now being adopted by various
enterprises as a component of their business intelligence.

For all business performance management processes, three main
activities are involved.

* Goal selection
* Information monitoring and consolidation

* Managerial adjustments
These three activities work together to improve efficiency and
performance, but it begins with goal selection. You can’t improve
performance if you don’t have a clear goal in mind.
Setting your goals helps businesses determine the exact methods and
processes that will help achieve those goals. Once the methods and
processes are determined, data is used to monitor them.
This information should be monitored both in real-time to allow for any
adjustments necessary and consolidated for regular review.
The consolidated metrics let businesses analyse the methods and
processes to identify strengths and weaknesses, so they can figure out
better methods and processes and continuously improve.
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After the data has been consolidated, teams led by management can
figure out which measures to take that could improve efficiency.
These changes are charted and analysed again to ensure success and
in turn, inform the new goals set as the last goals are achieved.

LIFE CYCLE OF BPM

Business process management activities can be arbitrarily grouped into
categories such as design, modeling, execution, monitoring, and
optimization.[21]

Business
Process
Management
Life-Cycle

Design

Process design encompasses both the identification of existing
processes and the design of "to-be" processes

Modeling

Modeling takes the theoretical design and introduces combinations of
variables (e.g., changes in rent or materials costs, which determine how
the process might operate under different circumstances).

Execution

Business process execution is broadly about enacting a discovered and
modelled business process.

Monitoring

Monitoring encompasses the tracking of individual processes, so that
information on their state can be easily seen, and statistics on the
performance of one or more processes can be provided.

Optimization

Process optimization includes retrieving process performance
information from modeling or monitoring phase; identifying the
potential or actual bottlenecks and the potential opportunities for cost
savings or other improvements; and then, applying those
enhancements in the design of the process
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6Q. Explain Role of User Interfaces in BI.

There are many business intelligence reporting tools on the market
today. In order to be effective, a Bl program must have a user interface
which communicates past, present, and predictive views of an
organization in a clear and customizable way. The new users are less
technically oriented, so they require an interface that is more intuitive;
one which can be mastered with a minimum of training.

Ul is created in layers of interaction that appeal to the human senses.
They include both input devices and output devices. Some of the types
of user interfaces are as follows:

Form-based user interface: Used to enter data into a program or
application by offering a limited selection of choices. For example, a
settings menu on a device is form-based.

Graphical user interface: A tactile Ul input with a visual Ul output
(keyboard and monitor).

Menu-driven user interface: A Ul that uses a list of choices to navigate
within a program or website. For example, ATMs use menu-driven Uls
and are easy for anyone to use.

Touch user interface: User interface through haptics or touch. Most
smartphones, tablets and any device that operates using a touch screen
use haptic input.

Voice user interface: Interactions between humans and machines
using auditory commands. Examples include virtual assistant devices,
talk-to-text and GPS.

7Q. Write about Cyclical process of a Business

Intelligence Analysis.

The business intelligence cycle helps to provide more relevant, accurate
and detailed data to help answer business questions.

In order to gather, integrate, analyze, and present data in a way that helps
corporate decision-making, business intelligence (Bl) also entails the use of
technology, tools, and methodologies.
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Business Intelligence Life Cycle

Phase 1: Analyze Business Requirements

The first step in the Business Intelligence life cycle is to analyse the business
requirements. The user identifies the business requirements in order to
determine the type of analysis that the user then needs to perform. Identifying
the requirements

For example, any retail company can analyse the sales data to figure out the
products that are top-selling and the products that least sell.

Phase 2: Design Data Model

Once the requirements are identified the user needs to design the logical
model according to the requirements. This logical model helps the user to
analyse the relationships that exist within the data entities.

For example, For any retail company, the data model consists of products,
their customers, and the sales data

phase 3: Design the Physical Schema

Once the logical model is prepared the next step is to design the physical
schema using the data model. The physical schema describes the structure
and the content of the data warehouse.

For example, in any retail company, physical schema consists of sales-
related facts, product-customer relationships, and the sales transactions

Phase 4: Build the Data Warehouse

Once the logical and physical schema is designed, the next step is to build
the data warehouse. The design of a data warehouse depends on the
physical and logical schema. After the design of the data warehouse, the data
and the content from the source system are loaded into the data warehouse

for further steps.
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For example, for the retail system, designing the data warehouse consists of
developing a database that would store the details of customers, products,
and other requirements for the business.

Phase 5: Create the Project Structure (Metadata)

The next step after designing the data warehouse is to create a project
structure also known as metadata. With the help of this created project
structure, the mapping of the tables and data in the data warehouse is easier.
Creating the project structure describes the further steps and types that need
to be implemented.

For example, The project structure of the retail company consists of the
attributes of the data, the design, and the working flow of the system. This
project structure or metadata gives a brief idea about the working of the
system.

Phase 6: Develop The Bl Objects

The next step is to develop the Bl objects such as metrics, attributes,
dashboards, reports, and facts. This step consists of developing the reports
and dashboards that can be used to analyse the data in the data warehouse.
For example, the retail company can develop reports and statistics charts that
can describe the profit and loss margins.

Phase 7: Administer and Maintain the Project
The last step is to administer and maintain the project continuously as it

undergoes changes. The project needs to be monitored to maintain the
changes, security, and performance of the system.

For example, the retail company needs to monitor the reports and statistics
accordingly to increase the profit of the sales.

Business Intelligence provides the proper approach for the data analysis and
decision-making process. It helps the business to achieve goals and gain
profits. The overall phases of business intelligence make the further
development and maintenance process easy.




UNIT II: Data Visualization
Data and Information Visualization- A brief history of Data Visualization- Data
Visualization for businesses- Different types of Charts- Business Activity Monitoring
through Dashboard - Emergence of Data Visualization and Visual Analytics.

1Q.Explain Data and Information Visualization.

Data visualization

Data visualization is the graphical representation of data to help people understand
the significance of information. It involves creating visual elements like charts,
graphs, and maps to communicate complex data in a way that is easy to comprehend.
The primary goal of data visualization is to provide insights, identify trends,
patterns, and outliers, and make data-driven decisions.

Here are key aspects and concepts related to data visualization:

1. Purpose and Importance:

o Understanding Complexity: Data visualization simplifies complex datasets,
making it easier for individuals to grasp patterns and trends that may not be
apparent in raw data.

« Decision Making: Visualizations aid in decision-making processes by
presenting information in a format that is intuitive and accessible.

2. Types of Data Visualizations:
Charts and Graphs: Common types include bar charts, line charts, scatter
plots, and pie charts.
Maps: Geographic data can be visualized using maps to show spatial patterns.
Infographics: Visual representations that combine charts, icons, and text to
convey information.
Dashboards: A collection of visualizations presented in a unified interface for
comprehensive data analysis.

3. Data Visualization Tools:

« Various tools like Tableau, Microsoft Power BI, Google Data Studio, and
open-source tools like Matplotlib and D3.js are used for creating
visualizations.

These tools often allow for interactive exploration of data, enabling users to
customize and manipulate visualizations.

4. Data Visualization Process:
Data Collection: Gathering relevant data from various sources.
Data Cleaning: Preprocessing and organizing data to remove errors and
Inconsistencies.
Analysis: Identifying patterns, trends, and insights within the data.
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Visualization Design: Choosing appropriate visualization types based on the
nature of the data and the desired insights.

Creation: Implementing the chosen visualizations using tools or
programming languages.

Interpretation: Analyzing the visualizations to draw meaningful conclusions
and make informed decisions.

. Best Practices:

« Simplicity: Keep visualizations simple and focused on the key message.
e Accuracy: Ensure that the visual representation accurately reflects the
underlying data.
o Interactivity: Utilize interactive features to allow users to explore the data.
. Common Challenges:
« Misinterpretation: Visualizations can be misinterpreted if not designed and
labeled accurately.
« Data Overload: Too much data can overwhelm users, making it essential to
focus on the most relevant information.
Information visualization
Information visualization is a specific subset of data visualization that focuses on
representing abstract and complex data in a visual form. The goal is to make
information more accessible, understandable, and insighttul for users. Information
visualization goes beyond simply presenting data; it aims to communicate meaningful
patterns, relationships, and insights in a way that enhances human cognition and
decision-making. Here are key aspects related to information visualization:

. Representation of Abstract Information:

« Information visualization deals with data that may not have a direct visual
analog, such as abstract concepts, relationships, or network structures.

o It often involves transforming high-dimensional or complex datasets into
visual forms that convey the essential information.

. Visual Encoding Techniques:

« Information visualization relies on various visual encoding techniques to
represent data. These include position, size, color, shape, and texture.

o Choosing the right visual encoding is crucial to effectively communicate
specific attributes of the data.

. Hierarchical Structures:

« Many datasets exhibit hierarchical structures. Information visualization can
represent these structures, such as organizational hierarchies, taxonomies, or
network relationships, in a visually intuitive manner.

. Interactive Visualizations:

« Interactivity is a key feature of information visualization. Users often need to
explore and manipulate the visual representation to gain deeper insights.

« Interactive elements allow users to filter, drill down, and dynamically adjust
parameters, enabling a more personalized and flexible exploration of the data.

SWAPNA A




5. Visual Analytics:

« Information visualization often integrates with analytical tools to enable users
to perform in-depth analysis directly within the visual interface.

o Users can discover patterns, anomalies, and trends by interacting with the
visual representation and applying analytical techniques.

. Applications:

« Information visualization finds applications in diverse fields such as scientific
research, business intelligence, journalism, education, and public policy.

« Examples include visualizing complex scientific data, financial trends, social
network relationships, and information tlows.

. Tools and Technologies:

« Various specialized tools and libraries are available for creating information
visualizations. These include D3.js, Plotly, and tools like Microsoft Power BI
and Tableau that support interactive and dynamic visualizations.

2Q). Write briefly about the history of Data

Visualization.
The history of data visualization can be traced back to ancient times when humans
used visual symbols and drawings to convey information. However, the evolution of
modern data visualization has been influenced by advancements in technology,
science, and communication. Here is a briet overview of key milestones in the history
of data visualization:

. Pre-20th Century:

« Ancient Maps: Early maps, such as those created by ancient civilizations like
the Babylonians, Egyptians, and Greeks, are early examples of visualizing
geographic information.

Statistical Graphics in the 18th Century: Figures like William Playfair and
Joseph Priestley began using graphical methods to represent statistical data in
the 18th century.

19th Century:

« Florence Nightingale's Rose Diagram (1858): Nightingale, a nurse and
statistician, used a polar area diagram (rose diagram) to illustrate the causes of
mortality in the Crimean War. This visualization emphasized the impact of
preventable diseases.

. Mid-20th Century:

« Development of Statistical Graphics: Statisticians like John Tukey and
William Cleveland contributed to the development of statistical graphics,
introducing concepts such as box plots and scatterplots.

Computers and Digital Visualization: With the advent of computers,

graphical representation of data became more sophisticated. Tools like early
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versions of Excel and statistical software enabled users to create basic charts
and graphs.
4. Late 20th Century:

« Emergence of Information Graphics: Newspapers and magazines began
using information graphics more extensively to convey complex news stories.
Edward Tufte, a pioneer in the field, published influential books on data
visualization principles.

Interactive Visualization: Tools like Tableau, introduced in the 2000s,
brought interactivity to data visualization, allowing users to explore and
manipulate visualizations dynamically.

5. 21st Century:

« Big Data and Advanced Visualization Tools: The rise of big data led to the
development of advanced data visualization tools capable of handling large
datasets. Tools like D3.Js and Python libraries like Matplotlib and Seaborn
gained popularity.

Open Data Movement: Governments and organizations began making large
datasets publicly available, fostering the growth of data visualization projects
for transparency and public awareness.

« Virtual and Augmented Reality: The exploration of virtual and augmented
reality for data visualization has gained traction, offering immersive
experiences for understanding complex datasets.

6. Current Trends:

« Al and Machine Learning Integration: Data visualization is increasingly
integrated with artificial intelligence and machine learning for automated
insights and pattern recognition.

Storytelling with Data: There is a growing emphasis on using data
visualization as a storytelling tool to convey narratives and engage audiences
effectively.

The history of data visualization is marked by a continuous evolution driven by
technological advancements, interdisciplinary collaboration, and the increasing
importance of data-driven decision-making across various domains.

3Q.Explain the Role of Data Visualization for various
businesses.

Data visualization plays a crucial role in various businesses across industries by
transforming raw data into meaningtul insights that can inform decision-making,
improve efficiency, and drive strategic initiatives. Here are key aspects of the role of
data visualization in businesses:

1. Decision-Making and Strategy:
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Enables executives and decision-makers to quickly grasp complex data.
Facilitates strategic decision-making by presenting key insights and trends.
Helps in identifying patterns, correlations, and outliers that impact business
strategies.
. Performance Monitoring:
Provides real-time or near-real-time dashboards for monitoring key
performance indicators (KPIs).
Enables businesses to track performance metrics and assess their progress
toward goals.
Allows for the identification of areas that need improvement or optimization.
. Financial Analysis:
o Presents financial data in visual formats such as charts and graphs for easier
Interpretation.
o Facilitates budget analysis, expense tracking, and revenue visualization.
« Aids in spotting financial trends and anomalies that may require attention.
. Marketing and Sales:
« Visualizes customer behavior, preferences, and buying patterns.
« Enhances marketing strategies by presenting data on campaign effectiveness.
o Helps sales teams identify opportunities, track leads, and analyze sales
performance.
. Customer Relationship Management (CRM):
« Provides insights into customer satistaction and feedback.
« Visualizes customer interactions and engagement levels.
o Assists in creating personalized customer experiences based on data analysis.
. Supply Chain and Logistics:
o Optimizes supply chain management by visualizing inventory levels and
demand patterns.
« Enables tracking of shipments, logistics, and delivery timelines.
« Identifies inefficiencies and bottlenecks in the supply chain for optimization.
. Human Resources:
« Visualizes workforce demographics, performance metrics, and employee
engagement.
« Aids in talent acquisition by presenting data on recruitment processes.
« Supports HR in workforce planning, training, and performance management.
. Healthcare Analytics:
« Visualizes patient data, treatment outcomes, and healthcare trends.
« Tacilitates clinical decision-making by presenting medical research findings.
« Improves efficiency in healthcare operations and resource allocation.
. Risk Management:
Visualizes risk factors and potential threats to the business.
Assists in identifying and mitigating risks through data analysis.
Provides a comprehensive view of risk exposure across various business

dimensions.
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10.Operational Efficiency:
« Helps in identifying bottlenecks and inefticiencies in processes.
« Enables continuous improvement by visualizing operational metrics.
o Streamlines workflows and resource allocation based on data insights.

In summary, data visualization is integral to modern business operations, providing a
visual language that enhances understanding and facilitates data-driven decision-
making across various functions and industries. It empowers businesses to leverage
their data for strategic advantage and adapt to dynamic market conditions.

Business Applications of Data Visualization
1. Business Intelligence
2. Finance Industries
. E-commerce
. Education
. Data Science
. Military
. Healthcare Industries

. Marketing
. Real Estate Business
10.Food Delivery Apps

4Q. Explain different types of Charts in Data

Visualization.

Data visualizations are graphic representations of data that help people understand
patterns and trends, identity relationships between variables, and spot outliers. This is
true even for complex datasets. Visual elements such as charts, graphs, and maps are
used to present information in an accessible and understandable way.

Different types of charts and graphs
1. Line charts
Purpose: Shows trends and changes over time.
Use Case: Displaying trends, patterns, or fluctuations in data over a
continuous interval.
Variations: Area chart (fills the area below the line), multiple line chart.

I|
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2. Bar charts
o Purpose: Compares individual data points or categories.
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« Use Case: Displaying and comparing the values of different categories or

groups.
e Variations: Clustered bar chart, stacked bar chart.

3. Scatter plots
o Purpose: Displays the relationship between two numerical variables.
o Use Case: Identifying correlations, clusters, or outliers in data.
o Consideration: Useful for highlighting patterns in bivariate data.

4. Pie charts
o Purpose: Represents parts of a whole.
o Use Case: Showing the percentage distribution of a categorical variable.
o Consideration: Best for a small number of categories to avoid visual clutter.

® O
5. Column charts

Column charts are the simplest, most versatile type of visualization used in data
analytics. The horizontal chart displays your data in bars proportional to the values they
represent.

Column chart

6. Tree map charts
Purpose: Visualizes hierarchical data as nested rectangles.

Use Case: Displaying proportions and hierarchical relationships within a
dataset.

Consideration: Useful for showcasing the hierarchical structure of categories.
N
— |

7. Gantt Chart
o Purpose: Illustrates project schedules and timelines.
» Use Case: Visualizing tasks, durations, and dependencies in project

management.
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« Components: Bars represent task durations, and dependencies are indicated
by arrows.

8. Heat map charts
o Purpose: Visualizes the magnitude of a phenomenon as color in a matrix.
o Use Case: Displaying relationships or correlations in a large dataset.
« Consideration: Often used in conjunction with hierarchical clustering

Heat Maps:

9. Geo charts
e Geo charts are a type of visualization that represent data on a map.

e They show spatial information, such as the distribution of values across different
regions, countries, or states.

-
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10. Waterfall charts

e A watertfall chart is like a visual story that helps you see how difterent things add
up to a final result. It explains how an initial value is affected by a series of
intermediate positive and negative values.

The waterfall chart receives its name due to its shape as it shows cascading
effects.

11. Bubble Chart
o Purpose: Extends the scatter plot to include a third dimension.
« Use Case: Visualizing three numerical variables simultaneously.

« Components: X and Y axes for two variables, bubble size represents the third
variable.

Bubble chart

12. Funnel Chart
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e A funnel chart shows a series of steps and the completion rate for each step.

e Use this type of chart to track the sales process or the conversion rate across a
series of pages or steps.

13. Area chart

e An area chart is basically a line chart, but the space between the x-axis and the
line 1s filled with a color or pattern.

14. Bullet graphs

e The bullet chart enhances a single bar with additional markings for
how to contextualize that bar’s value.

e This usually means a perpendicular line showing a target value, but
also background shading to provide additional performance
benchmarks.

15. Histogram
Purpose: Displays the distribution of a single numerical variable.
Use Case: Illustrating the frequency or density distribution of data.
Variations: Probability density function (smoothed version), stacked
histogram.

16. Box plots
Purpose: Represents the distribution of a dataset and identifies outliers.
Use Case: Visualizing the spread of data, identitying central tendency, and
detecting outliers.
Components: Box represents interquartile range, whiskers show data range,

and a line or dot may indicate the median.
— -
-
[ |

17. Stacked bar graphs
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These graphs are helpful when a group starts in one column and moves to
another over time.

Use this chart to compare many difterent items and show the composition of
each item you’'re comparing.

5Q. What is Dashboard? Write about Business Activity Monitoring through
Dashboard.

Dashboard:

Dashboard is a visual representation of data and key performance indicators (KPIs)
that enables users to monitor, analyze, and understand complex data sets quickly and
easily. Dashboards typically display data in a graphical format, such as charts,
graphs, and tables, and are designed to be interactive, allowing users to drill down
into the data to gain deeper insights.

Business Activity Monitoring (BAM) is the process of monitoring business
activities in real-time using dashboards and other visualization tools.

BAM dashboards provide a real-time view of key performance indicators
(KPIs) and other business metrics, allowing users to quickly identify trends,

patterns, and anomalies in the data.

BAM dashboards can be used to monitor a wide range of business activities,
including sales, marketing, operations, and finance. They can be customized
to suit the specific needs of the user, and can be integrated with other tools
and systems, such as databases, spreadsheets, and APIs, to provide a
comprehensive view of the data.

Some common features of BAM dashboards include:

. Real-time data updates: BAM dashboards are designed to update in real-
time, providing users with the latest information as it becomes available.

. Customizable layouts: BAM dashboards can be customized to suit the
specific needs of the user, allowing users to choose the data displayed and
the layout of the dashboard.

. Interactive visualizations: BAM dashboards often include interactive
visualizations, such as charts, graphs, and tables, that allow users to drill
down into the data to gain deeper insights.
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4. Alerts and notifications: BAM dashboards can be configured to send alerts
and notifications when certain thresholds are met, allowing users to take
action quickly.

. Historical data analysis: BAM dashboards can also include historical data
analysis, allowing users to identify trends and patterns over time.

By using BAM dashboards, businesses can improve their decision-making,
increase efficiency, and 1dentify opportunities for improvement. They can

also help businesses respond quickly to changing conditions, reducing the
risk of missed opportunities or negative outcomes.

Overall, BAM dashboards are a powerful tool for monitoring business
activities in real-time, enabling users to make informed decisions based on
the latest information.

There are several tools available for Business Activity Monitoring (BAM).
Some popular options include:

. Tableau: Tableau is a powertul data visualization tool that allows users to
create interactive dashboards and visualizations. It is widely used in
businesses for BAM and other data visualization purposes.

. Power BI

. OlikView

. Looker

. Google Data Studio
Example:

2

£680,950
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6Q. Explain Emergence of Data Visualization and Visual Analytics.

Data visualization and visual analytics are two terms that come up a lot when new
and experienced analytics users alike delve into the world of data in their quest to
make smarter decisions.
In a world increasingly dominated by data, users of all kinds are gathering,
managing, visualizing, and analyzing data in a wide variety of ways.
One of the downsides of the role that data now plays in the modern business world is
that users can be overloaded with jargon and tech-speak, which can be
overwhelming.
The emergence of data visualization and visual analytics can be attributed to several
factors, including the increasing availability and complexity of data, the increasing
importance of data-driven decision making, and the development of new
technologies.
Today, data visualization and visual analytics are critical skills for professionals in a
wide range of fields, and the fields continue to evolve and grow in response to new
technologies and changing needs.
Here, we'll dig into what these concepts are, their strengths, and how they work
together.
Data visualization: painting a picture of your data
e Simply data visualization means showing data in a visual format that makes
insights easier to understand for human users.
Data is usually visualized in a pictorial or graphical form such as charts,
graphs, lists, maps, and comprehensive dashboards that combine these multiple
formats.
The primary objective of data visualization is to clearly communicate what the
data says, help explain trends and statistics, and show patterns that would
otherwise be impossible to see.

Data visualization is used to make the consuming, interpreting, and
understanding data as simple as possible, and to make it easier to derive
insights from data.
When BI and analytics users want to see analytics results, and learn from them
quickly, they rely on data visualizations.
Visual analytics
[t does the “heavy lifting” with data, by using a variety of processes like mechanical,
algorithms, machine learning, natural language processing, etc — to identify and
reveal patterns and trends.

[t prepares the data for the process of data visualization, thereby enabling users to

examine data, understand what it means, interpret the patterns it highlights, and
help them find meaning and gain useful insights from complex data sets.
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Analytics and visualizations, the key to data-driven organizations
The relationship between data visualization and visual analytics is symbiotic. In

a study for the US Department of Homeland Security, James J. Thomas, and Kristin
A. Cook illustrate this relationship in what they describe as “The Sense-Making
Loop” of the analytical reasoning process:

Re-represent

The
Sense-Making

Produce Loop

Results

Develop
Insight

Good data visualization enables visual analytics to be more eftective and to show
users better insights and better insights make for more compelling visualizations.
Combining the two into visual data analysis makes it easier for users to better
understand their data. Together, they help organizations and individuals identify
how they can be more efficient, drive revenue, and gain a competitive advantage over
their competitors.

The role of visualizations in analytics
Data visualization can either be static or interactive.

Static visualizations provide users with a single view of what’s in front of them.
Interactive visualizations enable users to drill down into data and extract and
examine various views of the same dataset, selecting specific data points that they
want to see in a visualized format.

Data visualization is what provides clarity to data-driven insights and it’s what
enhances understanding throughout an organization.

—_— INTERACT\‘JALIZAT[ON
VISUAL

ANALYTICS

DATA
TRANSFORMATION
3 DATA
UNDERSTANDING
5 BUSINESS/CONTEXT
UNDERSTANDING

> CRITICAL THINKING
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In this diagram, visual analytics is shown to be the foundation for interactive data,
thereby demonstrating how the two are connected.

Analytics acts as the source for data visualization and contributes to the health of any
organization by identifying underlying models and patterns and predicting needs.
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Unit 111
Data Visualization with Tableau (1)

Working with Tableau Data Source and Basic Charts: Introduction to Tableau,
Connecting to Data Source: Text Files, Excel, Access, other databases, merging multiple
data sources, Univariate Charts — Creating tables, bar graphs, pie charts, histograms, line
charts, stacked bar graphs, box plots, Showing aggregate measures, Bivariate Charts —
Creating tables, scatter plots, swapping rows and columns, adding trend lines, selecting
color palettes, using dates.

Multivariate Charts and Maps: Facets, area charts, bullet graphs, dual axes charts,
Gantt charts, heat maps, Maps — Setting geographical roles, placing marks on map,
overlaying demographic data, choropleth maps, polygon shapes, customizing maps

Introduction to Tableau

Tableau is a powerful and widely used data visualization and business intelligence tool that
allows users to connect to various data sources, transform raw data into an understandable
format, and create interactive and insightful visualizations. It is designed to help people see
and understand their data by providing a user-friendly interface for creating dynamic
dashboards, reports, and charts.

Key Features:

1. Data Connectivity:

2. Tableau supports a wide range of data sources, including databases (SQL, Oracle),
spreadsheets (Excel), cloud-based sources (Google Analytics, Salesforce), and many
more.

. Data Preparation:
Users can clean, transform, and shape their data using Tableau's built-in data
preparation tools. This ensures that the data is in a suitable format for visualization.

. Drag-and-Drop Interface:
Tableau's intuitive drag-and-drop interface allows users to create visualizations by
simply dragging and dropping dimensions and measures onto the canvas.

. Interactive Dashboards:
Tableau enables the creation of interactive dashboards where users can explore and
interact with the data. Filters, highlight actions, and parameter controls enhance the
interactivity.

. Advanced Analytics:
Tableau supports advanced analytics and calculations. Users can create calculated
fields, use statistical functions, and implement forecasting to gain deeper insights
from their data.

. Multiple Chart Types:
It supports various chart types including bar charts, line charts, scatter plots, heat
maps,and geographical maps. Users can choose the most appropriate visualization
type for their data.

. Sharing and Collaboration:
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Tableau allows users to share their visualizations and dashboards with others.
Workbooks can be published to Tableau Server or Tableau Online, facilitating
collaboration and enabling access to live, interactive dashboards.

. Real-time Data Connection:
Tableau can connect to live data sources, ensuring that visualizations are always up-
to-date with the latest data.

Measures and Dimensions:

There are two types of values in the tableau:

Dimensions: Values that are discrete(which can not change with respect to time) in
nature called Dimension in tableau. Example: city name, product name, country name.
Measures: Values that are continuous(which can change with respect to time) in nature
called Measure in tableau. Example: profit, sales, discount, population.

Working with Values:

Continuous Values: Typically used for measures that have a range of values (e.g., Sales,
Temperature).

Discrete Values: Typically used for dimensions or measures with distinct categories (e.g.,
Year, Category).

Basic Workflow:
1. Connect to Data:
Import or connect to the data source of your choice.
2. Build Visualizations:
Use the drag-and-drop interface to create visualizations by placing dimensions and
measures on the canvas.
. Create Dashboards:
Combine multiple visualizations into interactive dashboards.
. Add Interactivity:
Utilize filters, parameters, and actions to enhance interactivity.
. Analyze and Explore:
Explore and analyze data dynamically by interacting with the visualizations.
. Share and Collaborate:
Publish your work to Tableau Server or Tableau Online for sharing and collaboration.

1Q. Explain the process of Connecting to Data Sourcs like Text Files, Excel and
Access in Tableau.

Connecting to various data sources in Tableau is a crucial step in the data visualization
process. Tableau supports a wide range of data sources, including text files, Excel
spreadsheets, Access databases, and various other databases. Additionally, Tableau allows
you to merge multiple data sources to create comprehensive visualizations. Here's a guide
on connecting to different data sources in Tableau:

Connecting to Data Sources:

Text Files (CSV, TXT):

Tableau can connect to the text file data and set up the data sources. Tableau connects to following
text files (*.csv, *.txt, *.tsv, *.tab).

How to Make the Connection and Set up the Data Sources

Step1: Open Tableau.

Step2: Below Connect, click on Text File.
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Step3: Go to the next screen,
Select the file you want to connect such as SalesJan2009.CSV

Click on Open option.
<i2| Open ]
~ [#3][ Scarch Downloads 2]

Date modified Type

30-Jun-19523PM  Microsoft Excel C.

&, Local Disk (C)
ca LocalDisk (D)~ <[

All Text Files ("6 ".csu " tab "t v

On the left-hand side of the data source, you will see the CSV file.

File Data Server Window Help

File name:  Sales)an2009.csv

# € >EC

Connections

SalesJan2009
Textfis

Files

Use Data Interpreter

Data Interpreter might be able to
clean your Text file workbook.

FR SalesJan2009.csv

F New Union

In short:

Click on "Connect" in the left sidebar.

Choose "Text File" and navigate to your CSV or TXT file.
Tableau will automatically detect the structure of your text file.

Excel Files:
Data Connection with Microsoft Excel
Stepa1: Click on the Microsoft Excel option given in the data tab.

Connect

Step2: In the next screen,
Select the Microsoft Excel file you want to connect such as sample-superstore.xls.

Click on open option.
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« [ 42 ][ Search Dawnioads

“ Name Date modified
v Favorites

B Desktop 5] Coffeexisx
& Downloads Y1 global_superstore_2016xlsx
5] Recent Places Y] Olympic Athletesalsx

B Sample - Superstorexls

icros
0 M
odifie

o
&) Pictures

BE Videos

8 Computer
&, Local Disk (C)
ca Local Disk ) = ¢

File name:  Sample - Superstoreals

Step3: It connects the Microsoft Excel file to Tableau. The sheets present in the Microsoft
Excel file are shown on the left-hand side of the window.

File Data Server Window Help

| € > &

Connections

Sample - Superstore

Sheets

MR Orders
BB People
FE Returns

FR Mew Union

Step4: You can drag one or more sheets from the sheets data tab such as Orders.

Sample - Superstore

AL

Then the data source looks like the below image:

B+ Orders (Sample - Superst..

In short:
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Click on "Connect" and choose "Excel."
Select the Excel file you want to connect to.
Tableau will display the available sheets; choose the one you want to use.
Microsoft Access:

a. Click on "Connect" and choose "Microsoft Access."

b. Browse and select your Access database file (.mdb or .acedb).

c. Choose the table or query you want to use.
Other Databases (SQL, Oracle, etc.):
Click on "Connect" and select the type of database you want to connect to (e.g., MySQL, SQL
Server).
Provide connection details such as server name, database name, and credentials.
Choose the table or write a custom SQL query to retrieve data.

2Q. Explain the concept Merging Multiple Data Sources in tableau.
Data Blending:
In Tableau, data blending refers to combining data. The crucial aspect of data blending is
that it combines the tables at the view level without actually performing a join between the
tables.
If the two data sources have different structures or if you want to keep them separate, you
can use Data Blending to combine them.

1. Connect to the first data source and create a worksheet.

2. Connect to the second data source and create another worksheet.

3. Drag a common field (e.g., a shared dimension) from one worksheet to the other to

create a relationship.

For example: Suppose a Sales data is present in a relational database and Sales Target
data in an Excel sheet.
How to do data blending
Tableau has two inbuilt data sources that are Sample coffee chain.mdb and Sample-
superstore, which can be used to illustrate data blending.
First, load the sample coffee chain into Tableau and visualize its metadata.
Go to the data source below connect — click on MS Access database file and browse for
the sample coffee chain file.

Union:
If the two data sources have the same structure, you can use the Union feature in Tableau to
combine them.
Union allows you to combine rows from two or more tables with similar structures.

1. Connect to the first data source, create a worksheet.

2. Connect to the second data source, drag it to the first in the Data Source tab, and

choose "Union."

Join:
Data joining is a common requirement in any data analysis. You may need to join data from
different tables in a single source or join data from multiple sources.
Tableau provides the feature to join the tables by using the data pane that is available in the
Data menu.
A join means combining columns from one or more tables in a relational database. It also
creates a set that can be saved as a table, or it can be used as it
Joining is used when you have a common field between two tables.

1. Connect to the first data source, create a worksheet.

2. Connect to the second data source.
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3. Drag it to the first in the Data Source tab, and choose the appropriate join type.
Joins are specifies into five types:

e Cross Join.

e Inner Join.

e Natural Join.

e Quter Join.

e Self-Join

Creating a Join in Tableau
Let's assume a data source Sample-superstore to create a join between two tables such
as Orders and Returns.

1. Go to the Data menu and choose Microsoft Excel option below connect.

2. Then select sample-superstore as a data source and click the Open button.

3. Drag Orders and Returns tables from sheets of the data source to the data pane.
Tableau will automatically create a join between Orders and Returns tables which
can be changed later as per required joins.

3Q. Explain Univariate Charts in detail with examples.

Uni means one and variate means variable, so in univariate analysis, there is only
one dependable variable. The objective of univariate analysis is to derive the data,
define and summarize it, and analyze the pattern present in it. In a dataset, it explores
each variable separately. It is possible for two kinds of variables- Categorical and
Numerical.

Univariate graphs plot the distribution of data from a single variable. The variable can be
categorical (e.g., race, sex, political affiliation) or quantitative (e.g., age, weight, income).

Tableau offers a variety of univariate charts that help visualize single variables or measures.
Here's a guide on creating some common univariate charts in Tableau:
1. Tables:
To create a table in Tableau:
Drag the dimensions and measures you want to include onto the Rows and Columns
shelves in the desired order.
. Tableau will automatically generate a table visualization based on the fields you've
selected.
. You can further customize the table by adjusting formatting options, such as font
size, alignment, and borders.

2. Bar Graphs:
The bar graph is very convenient while comparing categories of data or different groups
of data. It helps to track changes over time. It is best for visualizing discrete data.
To create a bar graph in Tableau:
1. Drag the dimension you want to use for the bars onto the Columns shelf.
2. Drag the measure you want to visualize onto the Rows shelf.
3. Tableau will automatically generate a vertical bar graph.
4. You can also create horizontal bar graphs by dragging the dimension to the Rows
shelf instead.
. Customize the appearance of the bar graph by adjusting colors, labels, and other
formatting options.
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3. Pie Charts:
Pie charts are mainly used to comprehend how a group is broken down into smaller
pieces. The whole pie represents 100 percent, and the slices denote the relative size of
that particular category.
To create a pie chart in Tableau:
1. Drag the dimension you want to use for the slices onto the Columns or Rows shelf.
2. Drag the measure you want to visualize onto the Angle shelf (located in the Marks
card).
3. Tableau will automatically generate a pie chart.
4. Customize the appearance of the pie chart by adjusting colors, labels, and other
formatting options.

4. Histograms:
Histograms are similar to bar charts and display the same categorical variables against
the category of data. Histograms display these categories as bins which indicate the
number of data points in a range. It is best for visualizing continuous data.
Histograms are used to display the distribution of continuous data.
To create a histogram in Tableau:
Drag the continuous measure you want to visualize onto the Columns shelf.
. Tableau will automatically generate a histogram with default bins.
. You can adjust the number of bins by right-clicking on the measure on the Columns
shelf, selecting "Edit", and adjusting the bin size.
. Customize the appearance of the histogram by adjusting colors, labels, and other
formatting options.

5. Line Charts:
Line charts are used to show trends over time or to connect individual data points.
To create a line chart in Tableau:
1. Drag the dimension containing your time data (e.g., date, month) onto the Columns
shelf.
. Drag the measure(s) you want to visualize onto the Rows shelf.
. Tableau will automatically generate a line chart.
. You can further customize the line chart by adding reference lines, adjusting line
styles, and formatting the axes.

Stacked Bar Graphs:

Stacked bar graphs are useful for comparing the parts to the whole across multiple
categories.
To create a stacked bar graph in Tableau:

1. Drag the dimension you want to use for the bars onto the Columns shelf.

2. Drag the measure(s) you want to visualize onto the Rows shelf.

3. Tableau will automatically generate a stacked bar graph.

4. You can further customize the stacked bar graph by adjusting colors, labels, and

sorting the bars.

7. Box Plots:
Box plots, also known as box-and-whisker plots, are used to display the distribution of a
continuous variable.
To create a box plot in Tableau:

1. Drag the continuous measure you want to visualize onto the Rows shelf.
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. Drag a dimension onto the Columns shelf to define the categories or groups for the
box plot.

. Tableau will automatically generate a box plot.

. You can further customize the box plot by adding reference lines, adjusting colors,
and adding additional fields for context.

4Q. Write steps for Showing Aggregate Measures in Tableau.
To show aggregate measures in Tableau, you typically perform the following steps:

. Connect to Your Data: Start by connecting Tableau to your data source.

2. Drag Measures to the View: Drag the measures you want to visualize from your
data source onto the Rows or Columns shelf. Tableau automatically aggregates the
measures based on the level of detail in your visualization.

. Aggregate Functions: Tableau provides various aggregate functions to compute
summary statistics such as SUM, AVG, MIN, MAX, COUNT, etc. You can apply these
aggregate functions to your measures directly in Tableau.

. Adjust Aggregation: By default, Tableau uses SUM aggregation for measures when
you drag them onto the view. However, you can change the aggregation method by
right-clicking on the measure in the Rows or Columns shelf, selecting "Measure" and
then choosing the desired aggregation function.

. Using Analysis Menu: Alternatively, you can use the Analysis menu to change the
default aggregation for measures. Go to Analysis > Aggregate Measures and choose
the desired function.

. Custom Aggregations: In some cases, you might need to create custom aggregations
by using calculated fields. You can create calculated fields in Tableau by using
formulas that combine existing fields and apply aggregation functions as needed.

. Using Marks Card: You can also apply aggregation to specific marks within your
visualization using the Marks card. For example, you can choose to display the
average value for a particular dimension by dropping the measure onto the Marks
card and changing the aggregation method.

. By following these steps, you can effectively show aggregate measures in Tableau and
create insightful visualizations based on your data.

5Q. Explain BIVARIATE CHARTS with examples.
Bi means two and variate means variable, so here there are two variables. The analysis is related to
cause and the relationship between the two variables. There are three types of bivariate analysis.

In Tableau, you can create bivariate charts such as tables, scatter plots, and line charts with ease.
Here's how you can do it, along with tips on swapping rows and columns, adding trend lines,
selecting color palettes, and using dates:
Creating bivariate charts like tables and scatter plots in Tableau allows for the visualization of
relationships between two variables. Here's how you can create them:
Tables:
To create a bivariate table in Tableau:
Drag the first dimension or measure you want to display onto the Rows shelf.
Drag the second dimension or measure you want to display onto the Columns shelf.
. Tableau will automatically create a table displaying the intersection of the two variables, with
the values aggregated according to the default aggregation method.
. You can further customize the table by adding totals, subtotals, and adjusting the formatting
as needed.
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Scatter Plots:
To create a bivariate scatter plot in Tableau:
1. Drag one dimension or measure to the Columns shelf.
2. Drag the other dimension or measure to the Rows shelf.
3. Tableau will automatically create a scatter plot with the variables plotted against each other.
4. You can customize the appearance of the scatter plot by adjusting the marks, colors, sizes,
and shapes to represent additional dimensions or measures.
5. You can also add trend lines, reference lines, and tooltips to enhance the visualization.

6Q. Explain the concepts
a) Swapping Rows and Columns in Tableau :
When you drag dimensions and measures onto the Rows and Columns shelves, Tableau
automatically arranges them in a default configuration.
1. To swap rows and columns in Tableau:
2. Simply drag a dimension or measure from one shelf to the other. For example, drag a
dimension from Rows to Columns or vice versa.
3. Alternatively, you can right-click on a dimension or measure and choose "Swap Rows and
Columns" from the context menu.
b) Adding Trend Lines:
Trend lines can help identify trends and patterns in your data.
1. To add a trend line to a scatter plot in Tableau:
2. Click on the Analytics pane on the left side of the screen.
3. Dragthe "Trend Line" option onto the visualization.
4. Tableau will automatically calculate and display the trend line based on the relationship
between the variables.
c¢) Selecting Color Palettes:
Color palettes can enhance the visual appeal and readability of your charts.
1. To select a color palette in Tableau:
2. Click on the color legend or the color shelf.
3. Choose "Edit Colors" to access the color palette options.
4. Select a predefined color palette or create a custom one according to your preferences.
d) Using Dates:
Dates are commonly used in time series analysis and trend visualization.
To use dates in Tableau:
1. Drag a date field from your data source onto the Rows or Columns shelf.
2. Tableau automatically recognizes the date field and aggregates the data accordingly (e.g., by
year, month, day).
3. You can further customize the date aggregation by right-clicking on the date field and
choosing from options such as Year, Quarter, Month, etc.
By leveraging these customization options, you can create insightful bivariate charts in Tableau that
effectively visualize the relationships between two variables, incorporate trend analysis, apply
appropriate color schemes, and utilize date-based insights.

7Q.Explain Multivariate Charts in detail with examples.

Multivariate charts and maps are powerful tools used in data visualization to represent
multiple variables simultaneously. They allow for the exploration of relationships and
patterns within complex datasets. Here are some common types of multivariate charts and
maps.

Facets: Facets, also known as small multiples, are a way to display multiple visualizations
of the same type side by side, each showing a subset of the data. This is particularly useful
for comparing different categories or dimensions within your dataset.

To create facets in Tableau:
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Drag the dimension you want to use for the facets (e.g., product category, region) to
the Columns or Rows shelf.
. Drag the measure you want to visualize to the Rows or Columns shelf to create the
individual charts.
. Tableau will automatically create multiple charts, one for each category or dimension
in the facet dimension.
. You can further customize the appearance of each chart to ensure consistency across
facets.
Area Charts: Area charts are similar to line charts but with the area below the lines filled
in with color. They are useful for visualizing the cumulative totals or proportions of multiple
variables over time or another continuous axis. Multiple variables can be represented by
different colored areas stacked on top of each other.
Area charts are useful for showing how data changes over time and for displaying the
cumulative total of multiple measures.
To create an area chart in Tableau:
1. Drag the dimension containing your time data (e.g., date, month) to the Columns
shelf.
. Drag the measure(s) you want to visualize to the Rows shelf.
. Tableau will automatically create a line chart.
. To convert it into an area chart, right-click on the chart, go to "Mark Type," and
select "Area."
. You can customize the appearance of the area chart by adjusting colors, labels, and
other formatting options.

Bullet Graphs: Bullet graphs are a type of bar chart designed to display a single measure
against a qualitative range of values, typically with performance thresholds.
To create a bullet graph in Tableau:
Create a bar chart with your measure(s) on the Rows shelf and the dimension(s) on
the Columns shelf.
. Duplicate the measure on the Rows shelf by right-clicking on it and selecting "Dual
Axis."
. For the second axis, change the chart type to a line chart.
. Adjust the size and formatting of the line chart to create the reference line for your
performance threshold.
. Remove unnecessary elements such as gridlines, axis labels, and headers to
streamline the appearance of the bullet graph.
. You can further customize the bullet graph by adding annotations, adjusting colors,
and fine-tuning the formatting to highlight key insights.

Dual Axes Charts: Dual axes charts have two y-axes that share the same x-axis. This
allows for the visualization of two different variables with different scales on the same chart.
For example, you might use a dual axes chart to compare the sales volume and sales price of
a product over time.
To create a dual axes chart in Tableau:
1. Drag the first measure you want to visualize onto the Rows shelf.

. Right-click on the measure on the Rows shelf and select "Dual Axis."

. Drag the second measure you want to compare onto the right side of the chart.

. Tableau will automatically create a dual axes chart with synchronized axes.

. Customize each axis independently by right-clicking on the axis and selecting "Edit

Axis."
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6. You can further customize the chart by adjusting colors, labels, and other formatting
options.

Gantt Charts: Gantt charts are used for visualizing project schedules, showing the start
and end dates of tasks or activities along a horizontal timeline. They can be used to visualize
multiple variables such as task duration, dependencies, and resource allocation within a
project.
Gantt charts are commonly used to visualize project timelines, showing the start and end
dates of tasks or activities.
To create a Gantt chart in Tableau:
. Drag the dimension containing your task or activity names onto the Rows shelf.
. Drag the dimension containing your start dates onto the Columns shelf.
. Drag the dimension containing your end dates onto the Columns shelf, next to the
start dates.
. Tableau will automatically create a Gantt chart with bars representing the duration of
each task.
. You can further customize the Gantt chart by adjusting colors, labels, and adding
additional fields such as task completion status.

Heatmaps: Heatmaps use color gradients to represent the intensity or magnitude of a
variable across two dimensions, typically displayed as a grid. They are useful for visualizing
patterns and correlations in large datasets. Multivariate heatmaps can display multiple
variables by using different color scales or by overlaying multiple layers of data.
Heat maps are effective for visualizing data density or patterns across two dimensions.
To create a heat map in Tableau:
1. Drag the dimension you want to use for the rows onto the Rows shelf.
2. Drag the dimension you want to use for the columns onto the Columns shelf.
3. Drag the measure you want to visualize onto the Color shelf.
4. Tableau will automatically create a heat map with color encoding representing the
measure values.
5. You can further customize the heat map by adjusting the color palette, adding labels,
and adjusting the level of detail.
Each of these multivariate chart types offers unique advantages for visualizing complex
datasets and can be tailored to suit the specific needs of your data analysis and
communication goals. When using multivariate charts, it's important to ensure that the
visualizations are clear, intuitive, and effectively communicate the insights present in the
data.

8Q. Explain steps for Setting geographical roles, placing marks on map,
overlaying demographic data in Tableau.

To set geographical roles, place marks on a map, and overlay demographic data using
Tableau, follow these steps:

1. Connect to your Data Source: Open Tableau and connect to your data source
that contains geographical and demographic data.

2. Assign Geographic Roles: Tableau has a feature called "Geographic Roles" that
automatically recognizes common geographic fields such as country, state, city, etc. If
your data contains such fields, Tableau will automatically assign geographic roles. If
not, you can manually assign geographic roles by right-clicking on the field and
selecting "Geographic Role" and then choosing the appropriate role.
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. Create a Map Visualization: Drag the geographic field (e.g., country, state, city)

to the "Rows" or "Columns" shelf. Tableau will automatically generate a map
visualization based on the geographic field.

. Overlay Demographic Data: To overlay demographic data, you need to have

demographic data in your dataset. You can then drag the demographic data fields
(e.g., population, income, age) to the appropriate shelves such as "Color", "Size", or
"Label" to overlay them on the map.

. Customize Map Marks: You can customize the marks on the map to represent

different demographic data points. For example, you can change the color, size,
shape, or label of the marks to better visualize the data.

. Apply Filters and Interactivity: Utilize Tableau's filters and interactivity features

to allow users to explore the data further. You can add filters for specific
demographic categories or time periods, and Tableau will dynamically update the
map visualization based on user interactions.

. Format and Design: Finally, format and design your map visualization to make it

visually appealing and easy to understand. You can adjust colors, fonts, borders, and
other design elements to enhance the clarity of the visualization.

. Publish and Share: Once you're satisfied with your map visualization, you can

publish it to Tableau Server or Tableau Public to share it with others. This allows
users to interact with the visualization online and explore the data on their own.

By following these steps, you can set geographical roles, place marks on a map, and overlay
demographic data using Tableau to create informative and visually engaging visualizations.

9Q. Explain Choropleth maps, polygon shapes, customizing maps in Tableau
with steps.

Creating choropleth maps and customizing polygon shapes in Tableau can provide powerful
visualizations for analyzing geographical data.
Here's how you can do it:

1.

Prepare your data: Ensure that your dataset contains geographical information
such as country, state, or region, along with the corresponding numerical values that
you want to visualize on the map (e.g., population density, income levels, etc.).

. Connect to your Data Source: Open Tableau and connect to your data source

containing the geographical and numerical data.

. Create a Map Visualization: Drag the geographic field (e.g., country, state,

region) to the "Rows" or "Columns" shelf.

. Tableau will automatically generate a map visualization based on the geographic

field.

. Convert to Polygon Shapes (Optional): If you want to customize the polygon

shapes on the map, you can convert your data into polygon shapes. To do this, you
need a dataset that includes the latitude and longitude coordinates for each shape.
You can then join this dataset with your existing data using a common geographic
identifier (e.g., country name, state code). After joining, Tableau will recognize the
data as polygon shapes.

. Create a Choropleth Map: To create a choropleth map, drag the numerical field

that you want to visualize onto the "Color" shelf.

. Tableau will automatically assign colors to different regions based on the numerical

values.

. You can customize the color palette, range, and legend to better represent your data.
. Customize Map Appearance: Tableau provides various options to customize the

appearance of your map. You can adjust the map layers, borders, backgrounds, and
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labels to improve readability and aesthetics. You can also add titles, annotations, and
tooltips to provide additional context for your visualization.

. Apply Filters and Interactivity: Use Tableau's filtering and interactivity features
to allow users to explore the data further. You can add filters for specific regions or
numerical categories, and Tableau will dynamically update the choropleth map based
on user interactions.

. Format and Design: Fine-tune the formatting and design of your choropleth map

to make it visually appealing and easy to understand. Experiment with different color

schemes, fonts, and layout options to enhance the clarity of the visualization.

. Publish and Share: Once you're satisfied with your choropleth map, you can

publish it to Tableau Server or Tableau Public to share it with others. This allows

users to interact with the visualization online and explore the geographical data on
their own.

By following these steps, you can create choropleth maps, customize polygon shapes,

and visualize geographical data effectively using Tableau.
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UNIT-1V:

Data Visualization with Tableau (2) User defined fields: Using predefined
fields, calculating percentages, applying if-then logic, applying logical
functions, showing totals and percentages, discretizing data,
manipulating text, aggregate data

1Q.what are User defined fields? Explain in detail.

In Tableau, user-defined fields can be created using calculated fields. Calculated
fields allow users to define new fields based on existing data in the dataset. These
calculated fields can perform various calculations, transformations, and logical
operations on the data.

Here's how you can create a user-defined field (calculated field) in Tableau:

. Open your Tableau workbook: Load the dataset you want to work with.

2. Navigate to the Data pane: In Tableau Desktop, you'll find the Data pane on the
left side of the screen.

. Right-click on "Measures" or "Dimensions'": Choose whether you want to
create a calculated field for a measure or a dimension. If you want to perform
calculations involving numerical data, right-click on "Measures". If you want to
create a calculated field based on categorical or descriptive data, right-click on
"Dimensions".

. Select "Create Calculated Field": After right-clicking on the appropriate
category (Measures or Dimensions), you'll see an option to create a calculated field.
Click on it.

Rename

Order Date Copy Values

Hide
02-03-2020
Create Calculated Field...

26-09-2017 Create Group...
21-07-2017

10-03-2018 Describe...

¥

Define your calculation: In the calculation dialog box that appears, you can
define your calculation using a formula. Tableau uses a formula language similar to
Excel's, so you can use familiar functions and operators. You can also refer to existing
fields in your calculation.

. Name your calculated field: Give your calculated field a descriptive name that
reflects the calculation it performs.




7.

8.

Click "OK": Once you've defined your calculation and given it a name, click "OK" to
create the calculated field.

Use the calculated field in your visualizations: Once created, your calculated
field will appear in the Data pane. You can now drag and drop it onto your
visualization canvas just like any other field in your dataset.

2Q. Explain the procedure for Calculating percentages in
tableau.

To calculate percentages in Tableau, you can use various methods depending on
what you're trying to achieve. Here are some common scenarios:

Percentage of Total: To show the percentage of each value relative to the total, you
can use Tableau's built-in table calculations.
o Drag the measure you want to calculate the percentage of onto the Rows or
Columns shelf.
e Right-click on the measure and go to "Quick Table Calculation" > "Percent of
Total."

. Percentage of Sub-Category Total: If you want to calculate the percentage of

each value relative to the total within a sub-category, you can use a table calculation
with a partitioning field.
Drag the measure you want to calculate the percentage of onto the Rows or
Columns shelf.
Right-click on the measure and select "Add Table Calculation."
In the calculation dialog, choose "Percent of Total."
In the "Compute Using" section, choose the appropriate field to partition the
calculation by.

. Percentage of Grand Total: To calculate the percentage of each value relative to

the grand total across all categories, you can create a calculated field.
o Go to Analysis > Create Calculated Field.
o In the calculated field dialog, enter a formula like:

SUM([Your Measure]) / TOTAL(SUM([Your Measure]))

o Drag this calculated field onto the Rows or Columns shelf.

. Custom Percentage Calculations: If you need to calculate percentages based on

custom logic, you can create calculated fields using Tableau's calculated field editor.
e Go to Analysis > Create Calculated Field.
e Define your calculation using Tableau's calculation syntax.

These methods should cover most scenarios for calculating percentages in Tableau.
Depending on your specific requirements, you might need to adjust the calculations
accordingly.

3Q. Explain if-then logic in detail.




In Tableau, you can apply if-then logic using calculated fields. Tableau's calculated
fields allow you to create custom expressions using a variety of functions, including
logical functions like IF-THEN-ELSE.

Here's how you can apply if-then logic in Tableau:

. Creating a Calculated Field: Go to Analysis > Create Calculated Field.
2. Writing the IF-THEN-ELSE Expression: In the calculated field dialog, write
your if-then logic using the IF-THEN-ELSE statement. The basic syntax is:

IF condition THEN result ELSE else result END

Example: IF [Sales] > 1000 THEN "High" ELSE "Low" END

This expression will return "High" if the sales are greater than 1000, otherwise, it will
return "Low".

. Using the Calculated Field: After creating the calculated field, you can use it like
any other field in your visualization. Drag the calculated field onto the Rows or
Columns shelf, or use it in filters, color encoding, etc.

That's how you can apply if-then logic in Tableau using calculated fields. This allows
you to perform custom calculations and segmentation based on your specific
requirements.

4Q. Explain logical functions in detail.

In Tableau, logical functions are used within calculated fields to manipulate data and
create conditional logic within visualizations. Tableau provides several logical
functions that allow you to perform operations based on conditions.

Logical calculations allow you to determine if a certain condition is true or false
(Boolean logic). For example, you might want to categorize values based on certain
cutoffs.

Lohéhlzal
Functions

In Tableau, you can apply logical functions to perform various operations on your
data. Here are some commonly used logical functions in Tableau:

1. IF-THEN-ELSE: The IF function allows you to perform conditional logic.




IF Statement

IF check THEN worth finish / IF check THEN worth ELSE else finish

Tableau IF statement creates a logical check. IF check is true THEN do y. The
check a part of the operations should be a mathematician, either by employing
a mathematician field within the knowledge supply or because of the results of
AN expression victimization operators or logical comparisons (AND, OR,
NOT).

Here’s an example:

IF { Internet users 2012 Internet Use THEN "Improvement"
ELSE "Regression" END

The basic syntax is:

IF condition THEN value ELSE value END

Example:

IF [Sales] > 1000 THEN "High" ELSE "Low" END
2. AND: The AND function checks if all conditions are true. It returns true if all

conditions are met, otherwise false.

AND(conditioni1, condition2, ...)

Example:

AND([Sales] > 1000, [Profit] > 500)
3. OR: The OR function checks if any of the conditions are true. It returns true

if at least one condition is met, otherwise false.

OR(conditioni, condition2, ...)

Example;

OR([Region] = "East", [Region] = "West")

. NOT: The NOT function negates the result of a condition. It returns true if

the condition is false, and vice versa.

NOT(condition)

Example:

NOT([Profit] < 0)

NOT([Region] = "East")

. IFNULL: IFNULL(expressioni, expression2)
The IFNULL statement primarily runs a true/false check on whether or not
the worth within the tested field is NULL. The primary worth within the
operate is employed if the worth isn’t null, and also the second is employed if
it’s null.

. ISNULL: This function checks if a value is null and returns true if it is,
otherwise false. The syntax is:

ISNULL(expression)
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1.

7. ZN Statement
ZN(expression)
The last logical Functions are that the atomic number 30 operate. It’s a
variation on the ISNULL and IFNULL operate. Atomic number 30 tests to
ascertain if a operate is null, and if it’s, it'll come back a price of zero.

ZN|([2014 Internet users]

. ISDATE Statement
ISDATE(string)
The ISDATE statement tests whether or not the string argument are often
born-again to a legitimate date (TRUE) or if it cannot (FALSE). Here’s AN
example:

. CASE Statement
CASE expression once value1 THEN returni once value2 THEN return2 ...
ELSE default come back finish
The CASE statement is employed to perform a logical check and come back
values supported the result. CASE operates are often rewritten as AN IF
function, however, the CASE Logical functions are usually times less
complicated to jot down and shorter.
Here’s AN example of a formula:

CASE mtry] WHEN “United States” THEN “USA” WHEN “United Kingdom”
THEN “UK” ELSE “WORLD” END

These logical functions can be used in calculated fields, filters, or as part of calculated
conditions within Tableau worksheets or dashboards. They provide flexibility in data
analysis and visualization by allowing you to create dynamic and conditional logic
based on your data.

5Q. Explain the procedure for Showing totals and percentages in tableau.

To show totals and percentages in Tableau, you can use table calculations and
calculated fields. Here's a step-by-step guide:

Create a Calculated Field for Percentage:

o First, create a calculated field to calculate the percentage for each row. Let's
call it "Percentage of Total".
The formula for calculating the percentage can vary based on your specific
requirements. For example, to calculate the percentage of sales for each row,
you can use the formula:

Drag and drop this calculated field onto the Measures or Text shelf in your
worksheet.
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. Show Totals:

o To show totals, right-click on the measure (e.g., Sales) in the Rows or Columns
shelf and select "Add Totals" -> "Row/Column Grand Totals".

. Format Percentage:

o Right-click on the "Percentage of Total" calculated field in the Data pane and
select "Default Properties" -> "Number Format".
o Choose Percentage and adjust any other formatting options as needed.

. Verify Calculation Settings:

o Ensure that table calculation settings are correctly configured for both the
measure and the calculated field. You can adjust the Compute Using settings
to define how the percentage is computed (e.g., by Table(down),
Table(across), etc.).

. Adjust Labels (Optional):

e You may need to adjust the label settings for the Totals row/column to ensure
that it displays correctly. Right-click on the totals row/column and select "Edit
Labels" to customize.

By following these steps, you can display both totals and percentages in your

Tableau visualization. This provides a comprehensive view of the data, showing

both the absolute values and their relative proportions.

6Q. Explain Discretizing of data in detail.

Discretizing data in Tableau involves converting continuous data into discrete
categories or bins. This is useful for grouping data into intervals or ranges, which can
then be used for analysis or visualization purposes. Here's how you can discretize
data in Tableau:

Discretization

—

BRefore

1. Create a New Calculated Field:

o Start by creating a new calculated field by right-clicking on the data pane and
selecting "Create" -> "Calculated Field".




o Give your calculated field a name, for example, "Discretized Category".
2. Write Calculation to Discretize Data:

Write a calculation that converts the continuous data into discrete categories

using functions like IF, CASE, or BIN.

For example, if you want to discretize a numeric field called "Sales" into

categories such as Low, Medium, and High, you can use a calculation like this:
IF [Sales] < 1000 THEN 'Low'

ELSEIF [Sales] >= 1000 AND [Sales] < 5000 THEN 'Medium'
ELSE 'High'
END

Alternatively, you can use the BIN function to create equal-width bins

BIN([Sales], 1000)
. Drag Calculated Field to Rows or Columns Shelf:

e Once you've created the calculated field, drag it to either the Rows or Columns
shelf to visualize the discretized data.

. Adjust Field Properties (Optional):

e You can further customize the discretized field by adjusting its properties. For

example, you can change the field alias to display more meaningful category
labels.

. Fine-Tune Bins (If using BIN function):

e Ifyou used the BIN function, you can adjust the bin size and alignment by
clicking on the drop-down arrow next to the calculated field in the view and
selecting "Edit Bins".

. Analyze and Visualize Discretized Data:

e Once the discretized data is visualized, you can analyze it using Tableau's
various features such as filtering, sorting, and aggregation.

By following these steps, you can discretize your data in Tableau, allowing for easier
analysis and visualization of continuous data by converting it into meaningful
categories or bins.
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7Q. Explain the concept Manipulating text in tableau.
1.Splitting Text:

e Use the SPLIT function to divide a text string into substrings based on a
delimiter. For example:
SPLIT([Text Field], " ")

This will split the text field into an array of substrings based on spaces.
2.Extracting Substrings:

e Usethe LEFT, RIGHT, or MID functions to extract substrings from a text
field. For example
LEFT([Text Field], 5)
This will extract the first 5 characters from the text field.

3.Concatenating Text:

e Use the + operator or the CONCAT function to concatenate multiple text
fields or strings. For example:
[First Name] + " " + [Last Name]

o This will concatenate the first name and last name fields with a space in
between.

4.Changing Case:
e Usethe UPPER, LOWER, or PROPER functions to change the case of text.

For example:
UPPER([Text Field])

This will convert all characters in the text field to uppercase.

6. Trimming Spaces:




e Usethe TRIM, LTRIM, or RTRIM functions to remove leading, trailing, or
both leading and trailing spaces from a text field. For example:
TRIM([Text Field])

8.Replacing Text:

e Use the REPLACE function to replace occurrences of a substring within a
text field. For example:
CONTAINS([Text Field], "substring")

8Q. Explain Data Aggregation in detail.

Data aggregation in Tableau involves combining and summarizing data to provide
insights and analysis. Here's how you can perform data aggregation in Tableau:

Connect to Data Source: Start by connecting Tableau to your data source, which
could be a database, Excel file, CSV, or any other supported format.

Drag and Drop: Once your data source is connected, Tableau will display a list of
dimensions (categorical variables) and measures (quantitative variables). Drag the
dimensions and measures onto the shelves in the Tableau workspace.

Measures

# Budget COGS

" Add to Sheet
Copy

Paste

Duplicate
Rename...

Hide

Create Calculated Field...
Create Group...
Create Bins...

Create Parameter...

Convert to Discrete

Convert to Dimension

Change Data Type 3

Geographic Role 3

Default Properties 3 Comment...

Replace References...
Describe... Number Format...
Aggregatiok * (@] Sum
Average
Median
Count

Count (Distinct)

Minimum
Maximum
Percentile 3
Std. Dev

5td. Dev (Pop.)
Variance

Variance (Pop.)

3. Aggregating Measures: By default, Tableau aggregates measures using SUM, but
you can change the aggregation method by clicking on the drop-down arrow next to
the measure and selecting a different aggregation function such as AVG, MIN, MAX,
COUNT, etc. You can also create calculated fields to perform custom aggregations.




[ SUM(Budget Margin) |
Filter...
Show Filter

Format...
Show Header
Include in Tooltip

Dimension

Attribute

Measure (Sum) L\x, Pl @ Sum
Average
Median

Discrete

Continuous
Count
Add Table Calculation...

Quick Table Calculation »

Count (Distinct)

Minimum

Remove .
Maximum

Percentile 3
Std. Dev

Std. Dev (Pop.)
Variance

Variance (Pop.)

Grouping Data: Tableau allows you to group data by dragging dimensions onto the
Rows or Columns shelves. You can group data at different levels of granularity to
perform aggregation at various levels.
Pivoting and Splitting: Tableau offers features like pivoting and splitting to reshape
your data for better aggregation. Pivoting combines multiple columns into a single
column, while splitting separates a single column into multiple columns.
Creating Hierarchies: Hierarchies allow you to drill down into your data,
aggregating at different levels of detail. You can create hierarchies by dragging
dimensions onto the hierarchy shelf.
Using Table Calculations: Table calculations in Tableau enable you to perform
complex calculations and aggregations based on the visualization's scope, such as
across rows, columns, or the entire table.
Custom Aggregations with LOD Expressions: Level of Detail (LOD) expressions in
Tableau provide the flexibility to perform aggregations at different levels of
granularity independent of the visualization.
Filters and Parameters: Apply filters and parameters to your data to control which
data is included in the aggregation.

10. Visualization: Once you have aggregated your data, you can create various
visualizations such as bar charts, line charts, scatter plots, etc., to analyze and present
your insights effectively.




UNIT-V: Data Visualization with Tableau (3)
Customization

Adding title and caption, font size and colors , adding various
marks, adding reference lines, using presentation mode,
adding annotation, adding drop-down selectors, search box
selectors, slider selectors, creating dashboards, creating
animated visualizations

1Q. Write the procedure for adding Title and Caption.

There are several ways text can appear on a sheet. You can show titles and captions
on any sheet.

These text elements can be customized for text properties like size, color, alignment,
and font, as well as element properties like shading and borders.

In Tableau, you can add a title and caption to your visualization to provide context
and explanation. Here's how you can do it

1. Adding a Title:
« Click on the worksheet tab where you want to add the title.
« From the menu bar, select "Worksheet" and then click on "Show
Title" to toggle the title on if it's not already visible.
« Click on the title to edit it, then type in your desired title.
2. Adding a Caption:
Navigate to the dashboard where your visualization is located.
Click on the "Text" object from the dashboard objects pane on the
left.
Drag and drop the text object onto your dashboard.
Position and resize the text box where you want the caption to
appear.
Type your caption into the text box.

Alternatively, you can add a caption directly within a worksheet by
creating a text box:

1. Adding a Caption to a Worksheet:
Click on the "Dashboard" tab at the bottom of the Tableau window.
Drag a text object from the Objects pane onto your worksheet.
Position and resize the text box where you want the caption to
appear.
Type your caption into the text box.
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font size and colors

2Q. Write the steps to modify Font Styles.

The proper font selection can take your visualization from good to great.
Whether you're changing the font size, position, color, or direction,
Tableau provides a wide range of customization options for your text.

When you make formatting changes at this level, they apply only to the
view you're working on. See Format at the Workbook Level to learn how
to make changes that apply to every view in your workbook.

To access worksheet-level format settings, select the Format menu,
then choose the part of the view, such as Font or Border, that you want
to format.

In Tableau, you can customize font size and colors for various elements
like titles, labels, tooltips, and text boxes. Here's how you can do it:

1. Changing Font Size:

« Worksheet Title: Click on the title, and in the title box, you'll see
options to change the font size. Alternatively, you can adjust it in
the "Format" menu under "Title" options.

Axis Labels and Titles: Select the axis, then click on the
dropdown arrow, and choose "Edit Axis." In the "Axis" dialog box,
you can change the font size under the "Title" tab.

Text Boxes: Click on the text box, then use the font size controls
in the toolbar or adjust it in the "Format" menu.

Dashboard Titles and Text: Click on the title or text box in the
dashboard, then use the font size controls in the toolbar or adjust it
in the "Format" menu.
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Format Workbook

Fonts

2. Changing Font Colors:
. Follow similar steps as above but instead of changing font size,
look for options to change font color.
For worksheet elements like axis labels and titles, you can typically
find color options in the "Format" menu.
For dashboard elements like titles and text boxes, you can find
color options by clicking on the element, then using the color
picker or selecting from predefined colors in the toolbar.
In Tableau, "marks" refer to the individual data points or visual elements
within your visualization. Tableau provides various ways to represent
data using different marks. Here's how you can add various marks in
Tableau

. Automatic Marks: When you first create a visualization in Tableau, it
automatically assigns marks based on the data type and the type of
visualization you choose. For example, if you create a bar chart, each
data point will typically be represented by a bar.

. Changing Mark Types:

Click on the drop-down menu next to "Marks" on the Marks card
in the "Marks" shelf.

Select a different mark type from the options available. Common
mark types include circles, squares, bars, lines, and areas.
Tableau will update the visualization accordingly, representing
each data point using the selected mark type.

. Dual-Axis Charts: You can add multiple mark types to a single
visualization using dual-axis charts. This allows you to overlay different
types of marks on the same axes.
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. Right-click on the secondary axis and choose "Dual Axis" from the
context menu.

For the second axis, you can select a different mark type or
visualization type, providing additional layers of information in
your visualization.

. Combining Multiple Measures or Dimensions:

« You can add multiple measures or dimensions to the Rows or
Columns shelf to create a multidimensional visualization.

« Tableau will automatically assign marks based on the combination
of fields you use, allowing you to explore relationships between
different variables.

. Custom Shapes:

. Tableau allows you to use custom shapes as marks. You can assign
specific shapes to data points based on a categorical field.

. To use custom shapes, create a calculated field that returns the
path to the shape file or use the built-in shape options available in
Tableau.

Adding reference lines

In Tableau, reference lines are helpful for indicating specific values or
thresholds within your visualizations. Here's how you can add reference

lines:

. Adding Reference Lines to Continuous Axes:
Right-click on the axis where you want to add the reference line
and select "Add Reference Line."
In the "Reference Line" dialog box, choose the "Line" tab.
Choose the aggregation method (e.g., Average, Median) and the
value you want to reference.
Customize the appearance of the reference line, including line
style, color, and label.
Click "OK" to apply the reference line to your visualization.
2. Adding Reference Lines to Discrete Axes:
. For discrete axes (such as dates or categories), you can add
reference bands instead of lines.
Right-click on the axis where you want to add the reference band
and select "Add Reference Band."
Follow the same steps as above to customize the reference band.
3. Addlng Multiple Reference Lines:
« You can add multiple reference lines to a single axis by repeating
the process above for each reference line you want to add.
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. Each reference line can have its own aggregation method, value,
and appearance settings.

. Adding Constant Reference Lines:

. Ifyou want to add a reference line with a constant value (e.g., a
goal or threshold), you can do so by selecting "Constant Line"
instead of "Field Value" in the "Reference Line" dialog box.

. Enter the desired constant value and customize the appearance as
needed.

. Adding Trend Lines:

Trend lines show the general trend of your data points.

Right-click on a data plot in your visualization and select "Trend

Lines."

Choose the type of trend line (e.g., linear, logarithmic) and

customize its appearance.

Adding various marks, adding reference lines, Using
presentation mode:

3Q. Write the steps for adding Marks and Reference
Lines

In Tableau, adding various marks and reference lines can help in
enhancing the visualization to better interpret the data. Here's how you
can do this:

Adding Various Marks

. Create a Chart:

First, ensure you have your data loaded into Tableau.

Drag the necessary fields to the Rows and Columns shelves to create
your basic chart.

. Change Mark Type:

Go to the "Marks" card on the left side.

Click on the drop-down menu to choose different mark types (e.g., Bar,
Line, Shape, Circle, etc.).

Select the appropriate mark type for your data visualization.
. Multiple Mark Types:
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If you need different mark types on the same chart, you can use a "Dual-
Axis" or "Combined Axis" approach.

For a dual-axis chart, drag another measure to the opposite axis (Rows
or Columns) and right-click on the axis to select "Dual Axis."

Synchronize the axes if needed by right-clicking on one of the axes and
selecting "Synchronize Axis."

In the "Marks" card, you'll now see different sections for each axis. You
can select a different mark type for each measure.
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. Detail, Color, Size, and Shape:

Drag fields to the "Detail," "Color," "Size," and "Shape" shelves within
the "Marks" card to add more layers of information.

For example, dragging a field to "Color" will color-code the marks based
on that field.

Adding Reference Lines

Data Analytics ¢ || ~ Pages jii Columns ﬂCourrtry
Summarize i= Rows SUM(Sales)

A Filters
# Constant Line

# Average Line Add a Reference Band
& Median with Quartiles ~ Marks Reference Band
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&
Model Color Size Label
& Average with 95% CI

=
& Median with 95% CI

Detail Tooltip

Custom

# Reference Line
@ Reference Band
&d Distribution Band
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. Add a Reference Line:

Click on the axis where you want to add the reference line.
Select "Add Reference Line" from the context menu.

. Configure the Reference Line:

In the "Add Reference Line, Band, or Box" dialog box, you can choose to
add a Line, Band, or Box.

Specify the scope (e.g., Entire Table, Per Pane, Per Cell).

Select the value for the reference line, which could be a constant value, a
computed average, median, minimum, maximum, or a parameter.

. Customize the Reference Line:

Set the label to show the value, custom text, or none.

Adjust the formatting options such as line style, thickness, and color.
. Add Reference Bands or Distribution:

Similar to reference lines, you can add reference bands (shaded areas) or
distribution bands to show ranges in your data.

Select "Add Reference Band" or "Add Reference Distribution" from the
context menu on the axis.

Segment

aximum =$1,161 401

5800000 Ayerage= $765,734
B I I

Using presentation mode, adding annotation

4Q. Explain in brief about Presentation Mode features
in Tableau.
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Tableau's presentation mode, known as "Presentation Mode" or "Full
Screen Mode," is a feature designed to make your visualizations look
clean and professional during presentations. Here’s how you can use and
optimize Presentation Mode in Tableau:

Accessing Presentation Mode

. Entering Presentation Mode:

Open your workbook in Tableau.

Click on the “Presentation Mode” button, which looks like a screen (located in the
top-right corner of the Tableau interface).

Alternatively, you can use the keyboard shortcut F7 (Windows) or Command +
Option + Return (Mac).

. Exiting Presentation Mode:

M

To exit, simply press the “Esc” key on your keyboard or click the “Close Full Screen’
button that appears when you move your mouse to the top of the screen.

Features of Presentation Mode

. Full-Screen View:

In Presentation Mode, Tableau removes all toolbars, shelves, and menus, allowing
the visualization to take up the entire screen.

This helps the audience focus on the data without distractions from the Tableau
interface.

. Navigation Controls:

You can navigate through different sheets and dashboards in your workbook using
the arrow keys on your keyboard.

Clicking on navigation buttons (if added to the dashboard) will also move you
between different views.

. Interactivity:

All interactive elements, such as filters, parameters, and actions, remain functional
in Presentation Mode.

You can still click on filters to adjust the view or use tooltips for more information.

. Annotations and Tooltips:
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e Annotations added to the visualization will still be visible in Presentation Mode.
e Tooltips will appear when you hover over data points, providing additional context.

The following table describes the different controls that are available when you are in presentation

mode. These controls are displayed in the bottom right cormer of the screen.

Show Filmstrip - shows the sheets as thumbnails

at the bottom of the workspace.

Show Tabs - shows the sheet tabs at the bottom

of the workspace.

Previous/Next Sheet - advances forward or

backward through the sheets in a workbook.

Enter/Exit Full Screen - switches between
expanding the workbook to fill the entire screen

and showing it in a window.

Exit Presentation Mode - returns the workbook
to showing the entire workspace including the

menus, toolbar, and the Data pane.

5Q. Explain about Annotations and drop-down
selectors in Tableau.

Annotations in Tableau help to highlight specific data points or areas
in your visualization, providing additional context and insights.

1. In a worksheet, right-click (control-click on Mac) a data point or a
spot on the viz where you want to add an annotation and
select Annotate, and then select the type of annotation you want
to add.

There are three types of annotations in Tableau:

o Mark - select this option to add an annotation that is
associated with the selected mark. This option is only
available if a data point (mark) is selected.

Point - select this option to annotate a specific point in the
view.

o Area - select this option to annotate an area in the viz, such
as a cluster of outliers or a targeted region.
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2. In the Edit Annotation dialog box that opens, type the text you
want to show in the annotation.

Use the Insert menu to insert dynamic variables into the
annotation text. For example, the annotation can display data
values that update as the underlying data changes. The dynamic
variables that are available are dependent on whether you are
annotating a mark, point, or area.

. When finished, click OK.

The updates with your annotation.

Edit an annotation
To edit an annotation:

1. Right-click (control-click on a Mac) the annotation in the viz and
select Edit.

2. In the Edit Annotation dialog box that opens, edit the annotation
text and then click OK.

[ susksoe ____J

Drop-down selectors
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Drop-down selectors in Tableau (typically filters) allow users to
dynamically adjust the data displayed in the visualization.

. Create a Filter:

Drag a dimension or measure to the “Filters” shelf.

In the “Filter Field” dialog box, select the appropriate filter options and
click “OK.”

. Show Filter Control:

Right-click on the filter you added to the “Filters” shelf.
Select “Show Filter” to display the filter control on the worksheet.

. Customize Filter Display:

Click on the drop-down arrow on the filter control.

Choose “Single Value (Dropdown)” to convert the filter into a drop-down
selector.

You can also choose other display options like “Single Value (List),”
“Multiple Values (Dropdown),” or “Slider,” depending on your needs.

. Filter Across Multiple Worksheets:

To apply the same filter across multiple worksheets, right-click on the
filter control.

Select “Apply to Worksheets” and then “Selected Worksheets.”
Choose the worksheets where you want the filter to apply and click “OK.”

— click the arrow and
rightclickand = select Multiple values
(dropdown)
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Search box selectors and slider selectors

6Q. Explain procedure for search box selectors and
slider selectors in Tableau.

Search Box Selectors

A search box selector allows users to quickly find and select items from a
long list of values.

. Create a Filter:

Drag a dimension (e.g., "Product Name") to the "Filters" shelf.

In the "Filter Field" dialog box, select the values you want to include and click "OK."

. Show Filter Control:

Right-click on the filter you added to the "Filters" shelf.
Select "Show Filter" to display the filter control on the worksheet.

. Enable Search Box:

Click on the drop-down arrow on the filter control.

Choose "Multiple Values (Custom List)." This will display a search box at the top of
the filter control.

Users can now type in the search box to filter the list of values.

Slider Selectors
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A slider selector allows users to select a range of values, which is
particularly useful for date or numeric filters.

. Create a Numeric Slider:

Drag a measure (e.g., "Sales") to the "Filters" shelf.

In the "Filter Field" dialog box, choose to filter by a range of values (e.g., "All values"
and then "Range of values").

Set the range and click "OK."
. Show Slider Control:

Right-click on the filter you added to the "Filters" shelf.
Select "Show Filter" to display the filter control on the worksheet.
The filter will automatically be displayed as a slider.

. Create a Date Slider:

Drag a date dimension (e.g., "Order Date") to the "Filters" shelf.

In the "Filter Field" dialog box, choose the range of dates you want to filter by and
click "OK."

. Show Date Slider Control:

o Right-click on the filter you added to the "Filters" shelf.
o Select "Show Filter" to display the filter control on the worksheet.

e Click on the filter drop-down arrow and ensure it is set to "Range of Dates." This will
display the filter as a date slider.

Creating dashboards and animated visualizations

~7Q. Explain about creating dashboards and animated
visualizations.
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Creating dashboards in Tableau involves combining multiple sheets into a single
interface to provide a comprehensive view of your data. Here's a step-by-step guide
to help you create effective dashboards:

Create a Dashboard

You create a dashboard in much the same way you create a new
worksheet.

1. At the bottom of the workbook, click the New Dashboard icon:

Table Map LT'.'l_ EE'|_

From the Sheets list at left, drag views to your dashboard at right.

Add Sheets to the Dashboard

. Drag Sheets onto the Dashboard:

From the left pane, drag the sheets you want to include onto the dashboard canvas.

You can arrange and resize the sheets by clicking and dragging their borders.

. Add Containers:

Use horizontal or vertical containers to organize the layout of your sheets.

Drag a container from the Objects section and place it on the dashboard, then drag
your sheets into the container.

Add Interactivity

1. Add Filters:

o Ifyou want a filter to control multiple sheets, drag the filter onto the dashboard.
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After placing the filter, click on its drop-down menu and choose “Apply to
Worksheets” > “Selected Worksheets” or “All Using This Data Source.”

. Add Actions:

Go to “Dashboard” in the top menu and select “Actions.”
Click “Add Action” and choose the type of action (Filter, Highlight, URL, etc.).

Define the source and target sheets for the action, and set the action's behavior (e.g.,
how it should be triggered).

Animated visualizations

Animated visualizations in Tableau can make your data storytelling more dynamic
and engaging. Here’s how you can create and use animations in Tableau:

1. Preparing Your Data and Initial Visualization
. Load Your Data:

Open Tableau and connect to your data source.
. Create Your Base Visualization:

Drag the necessary dimensions and measures to the Rows and Columns shelves to
create the base visualization.

For example, to create an animated scatter plot, drag a measure like "Sales" to
Columns and another measure like "Profit" to Rows.
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3. Adding the Animation

Parameters...

Cell Size
Workbook Theme

. Add a Time Dimension:

Drag a time-related dimension (e.g., "Order Date") to the Pages shelf.

The Pages shelf is specifically designed for creating animations and will create a
separate view for each time period.

. Configure the Pages Shelf:

After dragging the time dimension to the Pages shelf, a Pages card will appear.

The Pages card allows you to control the animation, including play, pause, and step
through each time period.

Choose the level of granularity for the time dimension (e.g., year, quarter, month, or
day).

. Customize the Animation:

Adjust the speed of the animation using the control on the Pages card. You can
choose from slow, medium, or fast.

4. Enhancing the Animation

Animations

Workbook Default

- o

Duration
0.30 seconds (Fasty

Style

Simultaneous -

Selected Sheet

(Marie Selevied)

5.

1. Add Filters and Parameters:
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Add filters or parameters to allow users to interact with the visualization while it
animates.

For example, add a filter to show data for specific regions or categories.

. Use Motion and Transitions:

In Tableau 2020.1 and later, you can use animations for transitions between filter
changes, parameter updates, and sorting.

Go to “Format” > “Animations” to enable and configure animations for sheet
transitions.

START DATE EN0 DATE
11/4/2019  Select an End Dat

NOVEMBER 2019
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